
 

  

 

 

 

Photoshop 



Photoshop 

 

Para iniciar, não é necessário que você seja o gênio das artes, afinal nas 

últimas versões do Photoshop muitas ferramentas e efeitos estão sendo 

realizados quase que automáticos, assim facilitando a vida do iniciante. 

 

Algumas anotações importantes: 

Menu Principal 

Barra de Propriedades 

Caixa de Ferramentas 

Painéis 

Área de Trabalho 

Área do Documento 

 

Vamos abrir a nossa imagem e tentar dar-lhe uns tons não muito fortes para o 

resultado ser o mais natural possível. 

Neste caso a primeira coisa que fiz foi ajustar as curvas da foto (CTRL+M) para 

a tornar ligeiramente mais clara principalmente na zona do rosto que é o que 

queremos destacar. 

Agora vem a parte da "mudança" que, ao contrário do que poderiam pensar, 

não é tão complicado assim. Vamos alterar a cor do cabelo/sobrancelhas, 

maçãs do rosto, lábios e salientar mais a cor dos olhos. Para cada um destes 

pontos vamos fazer o seguinte: 

 

 

Cabelo/Sobrancelhas, lábios e olhos: 

 

1º SHIFT+CTRL+N para cada um dos detalhes (ou seja 3 layers vazias neste 

caso) onde vamos pintar o cabelo/sobrancelhas (mesma layer), lábios 

(seleccionar outra layer vazia e pintar) e olhos (seleccionar a 

terceira layer vazia e colorir); 

 

2º Alterar a blending option (b.o.) da layer de Normal para Overlay; 



3º Escolher a cor para pintar o respectivo detalhe 

(caso não gostem da cor e já tenham pintado, não se preocupem... podem 

apagar com a borracha e voltar a pintar com outra cor); 

 

4º Ajustar a opacidade (opacity) consoante a quantidade de cor que queremos 

(+ claro/+ escuro) e ir vendo como fica na foto. 

 

 

Maçãs do rosto: 

 

1º SHIFT+CTRL+N para este detalhe também (ou seja 1 layer vazias); 

 

2º Alterar a blending option (b.o.) da layer de Normal para Color; 

 

3º Escolher a cor para maquilhar (normalmente rosa ou vermelho escuro); 

 

4º Ajustar a opacidade (opacity) consoante a quantidade de cor que queremos 

(+ claro/+ escuro) e ir de novo vendo como fica na foto. 

 

Em todos estes passos não se preocupem se pintarem fora das zonas. Usem a 

borracha com uma dureza (hardness) de cerca de 10/20% e apaguem nos 

sitios que não devem ter cor para que o trabalho fique perfeitinho. E também 

não esqueçam de usar a borracha no sitio dos dentes para que estes não 

fiquem coloridos. Depois podemos unir tudo fazendo merge 

down (SHIFT+CTRL+E). 

 

Como os olhos são um dos elementos faciais que mais se destacam nas fotos, 

vamos dar especial atenção a eles. Neste caso, apliquei umas pestanas falsas 

e escureci o sobrolho para que o retrato parecesse mais maquilhado. Tenham 

o cuidado de guardar o arquivo neste caminho (ou semelhante) do vosso 

computador "C:\Program Files\Adobe\Adobe Photoshop CS4\Presets\Brushes". 

Para não perderem o trabalho basta fazerem Ficheiro/Abrir... (File/Open...) e 

vão à pasta acima onde vão seleccionar o brush (deve estar com este nome 

"eyelashes_____by_trisste_deviantart_com") e clicam em abrir. 

 

1: À semelhança do que fizemos para maquilhar o cabelo e afins, também aqui 

vamos criar uma layer vazia para cada pestana. A seguir seleccionamos 



a brush tool  e onde habitualmente está um círculo, (na barra das 

definições da ferramenta) vamos percorrer o menu e seleccionar o 

nosso brush. Temos de ter cuidado para ajustar o tamanho do brush(master 

diameter) para o tamanho do olho (ver imagem ao lado). 

 

 

2: Carimbar a pestana por cima do olho esquerdo (com a layer "pestana 

esquerda" seleccionada). Atenção que é necessário a foregound color 

 ser o preto. Depois de carimbar uma pestana, fiz CTRL+T para a seleccionar 

na totalidade e com o botão do lado direito cliquei e seleccionei a opção warp 

tool. Esta parte exige alguns conhecimentos de como manusearuma 

imagem. O brush vai ficar com uma espécie de grelha onde podemos mexer, 

puchar, encolher... etc. Basta experimentarem que logo percebem como 

funciona. 

 

 

3: Fiz o mesmo procedimento para a pestana direita (com a layer pestana 

direita seleccionada) e com a borracha dei uns toques e apaguei zonas que 

não queria que o brush preenchesse. 

 

 

4: A seguir para dar um toque mais real, seleccionei a burn tool  com os 

valores abaixo e retoquei nas zonas mais escuras para não se notar a 

diferença do olho para o sítio onde a pestana foi colocada e ficar tudo mais 

uniforme. Dei também um toque no sobrolho para parece mais maquilhado. 

Com a dodge tool  seleccionada e com os valores abaixo, ponteei o brilho 

do olho para o salientar mais um pouco. A seguir tem de se unir tudo de novo 

(SHIFT+CTRL+E).  

 

Vamos agora alisar ligeiramente a pele. Para isso duplicamos a layer (CTRL+J) 

e vamos usar a blur tool  para passar na pele do rosto e do ombro (que é o 

que está focado na fotografia). Não se preocupem se ficar demasiado alisado 

ou pastel. A seguir podem ajustar a opacidade ao vosso gosto (como na 

imagem abaixo) e ficar com a tez mais natural. 

E aqui está a nossa imagem final. Apenas adicionei um ligeiro detalhe que foi 

pintar com um tom suave (cinza neste caso) à volta da modelo para a foto não 

ficar tão branca.  
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Adobe Photoshop é um software caracterizado como editor de 

imagens bidimensionais do tipo raster(possuindo ainda algumas capacidades 

de edição típicas dos editores vectoriais) desenvolvido pela Adobe Systems. É 

considerado o líder no mercado dos editores de imagem profissionais, assim 

como o programa de facto para edição profissional de imagens digitais e 

trabalhos de pré-impressão. 

Sua mais recente versão é apelidada como Adobe Photoshop CC (sigla cujo 

significado é Creative Cloud, correspondente à sua décima quarta edição [14.0] 

desde seu lançamento), disponível para os sistemas operativos Microsoft 

Windows e Mac OS X. Pode ser rodado também no Linux, através da camada 

de compatibilidade Wine. Algumas versões anteriores foram lançadas também 

para IRIX, mas o suporte a esta versão foi descontinuado após a versão 3.0. 

 

O software Photoshop foi concebido em 1987, por Thomas Knoll, na Califórnia, 

Estados Unidos. Knoll estava em casa trabalhando em sua tese de doutorado, 

quando criou um código em seu computador que exibia imagens em tons de 

cinza em um monitor de bitmap preto e branco. Como o código não estava 

diretamente relacionado à sua tese de doutorado, Knoll subestimou o seu valor. 

Mal sabia ele que esse era o primeiro esboço do fenômeno Photoshop. 

Só mais tarde, quando seu irmão John Knoll, que na época já trabalhava na 

ILM (Industrial Light & Magic), se encantou pelo programa, que ele percebeu 

seu potencial. Ambos trabalharam juntos para desenvolvê-lo e em 1990 o viram 

lançado pela Adobe, que havia comprado o programa. 

Os irmãos Thomas Knoll e John Knoll iniciaram o desenvolvimento do 

Photoshop em 1987 e a versão 1.0 foi lançada pela Adobe em 1990. O 

programa era destinado desde o início como ferramenta de manipulação de 

imagens provenientes de digitalizadores, que eram raros e dispendiosos 

naquela época. 

Apesar de ter sido concebido para edição de imagens para impressão em 

papel, o Photoshop está a ser cada vez mais usado também para produzir 

imagens destinadas à World Wide Web. Até a versão 9.0 (CS2) o programa, 

o Adobe ImageReady, muito semelhante ao Photoshop, que era utilizado em 

conjunto para a edição e criação de imagens e animações para a internet. A 

partir da versão 10 (CS3), os recursos do Adobe ImageReady estão incluídos 

dentro do próprio Photoshop. 

O Photoshop também suporta edição com outros tipos de programas da 

Adobe, especializados em determinadas áreas: o já referido Adobe 

ImageReady (edição de imagens para a web), Adobe InDesign (edição de 
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texto) Adobe Illustrator (edição de gráficos vectoriais), Adobe Premiere (edição 

de vídeo não-linear), Adobe After Effects (edição de efeitos especiais em vídeo) 

e o Adobe Encore DVD (edição destinada a DVDs). Os formatos de arquivos 

nativos do Photoshop (PSD ou PDD) podem ser usados entre estes 

programas. 

A título de exemplo, o Photoshop CS permite fazer elementos da interface 

gráfica de DVDs (menus e botões), desde que dispostos separadamente no 

ficheiro original (PSD ou PDD) por camadas (layers) agrupadas por ordem 

específica, de forma que, ao ser importado pelo Adobe Encore DVD, este 

consiga criar a edição para DVD com esses elementos. 

O uso das camadas não é um recurso novo inventado pelos desenvolvedores 

do Photoshop, ele foi desenvolvido há muito tempo pelos ilustradores. Segundo 

Richard Valliere em seu livro, Manipulator of Movement: "[…]em dezembro de 

1914 é patenteada aquela que efectivamente foi a maior contribuição técnica 

para a animação tradicional até o advento da computação gráfica: o desenho 

sobre folhas de celulóide transparente – em português vulgarmente chamada 

de acetato". Essa inovação coube ao animador norte-americano Earl Hurd."  

Portanto, é mais um recurso existente no mundo real que foi aproveitado pela 

ferramenta Photoshop para facilitar o trabalho de seus usuários, assim como 

certos efeitos que reproduzem técnicas de pintura, máscaras, uma técnica 

muito utilizada em gráficas e impressão offset. 

Os formatos de arquivos nativos podem ser importados de programas da 

concorrência, como o Corel Photo-Paint, Pixel32, WinImages, GIMP, Corel 

Paint Shop Pro, etc. 

O Photoshop suporta vários espaços de cor (color spaces): 

sRGB (ponto branco=D65) - RGB no Photoshop 

Lab (ponto branco=D50) 

CMYK 

Escala de cinza (Grayscale) 

 

Em 2002, a Adobe incluíu o Adobe Camera RAW, um plugin desenvolvido por 

Thomas Knoll que permite ler vários formatos de ficheiros RAW, provenientes 

principalmente de máquinas fotográficas profissionais. Uma versão preliminar 

deste plugin esteve opcionalmente disponível para o Photoshop 7.0.1 a $99 

dólares americanos. 
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Em 2012 foi lançcda a versão 13.0, também chamada de "Photoshop CS6", 

uma vez que "CS" indica a sua integração no pacote de programas Adobe 

Creative Suite. Quanto ao número "6" é por ser a sexta versão desde que a 

Adobe reformulou a imagem de marca dos seus programas sob a "marca-mãe" 

(no inglês umbrella brand) "Creative Suite". 

Numa tentativa de se separar da imagem de marca anterior do Photoshop, 

entre as versões 3 e 7, em que apresentava o olho humano (num conceito de 

visão e imagem), nas duas primeiras versões do "Creative Suite" utiliza 

imagens de penas estilizadas (como referência à escrita e pintura com penas 

de aves), mais recentemente, já na terceira edição do "CS", a imagem foi 

alterada para um quadrado com as letras "PS" ao centro. 

Enquanto o Photoshop é praticamente utilizado por profissionais, o seu preço 

elevado deixa margem para outros programas concorrentes ganharem 

mercado em outras faixas de mercado, como por exemplo, o GIMP, que é um 

programa gratuito, ou Pixelmator, que é um editor semelhante para a 

plataforma Macintosh. De forma a competir com este mercado, e também para 

combater a pirataria de que o Photoshop é alvo, a Adobe lançou um programa 

semelhante para o mercado doméstico, o Adobe Photoshop Elements, mas 

com muitas funções profissionais removidas do Photoshop original. Enquanto o 

Adobe Photoshop CS3 é vendido por sensivelmente 800 euros (versão 

inglesa), o Adobe Photoshop Elements 4.0 custa apenas 130 euros, de forma a 

ganhar terreno no mercado doméstico. Sendo mesmo, por vezes incluído 

em digitalizadores de diversas marcas. Como é óbvio, esta versão "reduzida" 

não se adequa ao mercado de pré-impressão profissional, visto uma das 

principais características removidas deste software seja o modo de 

cores CMYK. 

O Photoshop não suporta nativamente muitos dos algoritmos de 

imagem (Image Arithmetics) que o Corel Paint Shop Pro e outros editores de 

bitmaps utilizam. No entanto, esse problema pode ser contornado através 

do Filter Factory, um plugin gratuito disponível nos discos de instalação do 

Photoshop, após a versão 3.0. 

O termo photoshopping (também "photoshopar" no Brasil) é 

um neologismo que significa "editar uma imagem" independentemente do 

programa que se utilize (de forma similar ao neologismo Googlar). A Adobe 

desencoraja o uso do termo devido ao receio de distorcer a imagem de marca 

da empresa. O termo "photoshop" também é usado como substantivo 

relativamente à imagem alterada. São termos populares utilizados por 

membros de sites como "Something Awful", "Fark.com", "B3ta" ,"Desafios 

Photoshop Brasil" e "Worth1000". O objectivo de alterar uma imagem é torná-la 

humorística ou inteligente, muitas vezes através de referências a piadas e à 

cultura pop. Numa vertente mais recente neste âmbito é a 
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chamada fake (traduzida por falso), em que se alteram imagens parodiando 

figuras célebres, com imagens de nus ou pornográficas. Surgiram até 

concursos de Photoshop em que profissionais e amadores competiam para 

mostrar as suas capacidades de edição de imagens nestas vertentes. 

O termo é também por vezes utilizado por artistas, para se referir a imagens 

que tenham sido retocadas (retouched) ao invés das imagens originais. Um 

problema comum entre os vários tipos de utilizadores do Photoshop é evitar 

que os seus trabalhos se pareçam com o "aspecto Photoshop" (intrínseco entre 

todos os programas de edição de imagem). 

Também recentemente, o Photoshop é usado para alterar e desenhar veículos, 

normalmente carros, processo esse, denominado por digi-

modding, photoshopping ou tuning virtual. Já são muitos os sites que se 

dedicam a este aspecto, e este novo tipo de "arte" tem-se expandido. E apesar 

dos sites, permitirem às pessoas mostrarem os seus carros, publicamente na 

internet, os carros manipulados digitalmente já existem há muito tempo nas 

revistas de automóveis. 

 

Formato PSD 

 

Formato padrão da Adobe para documentos do Photoshop. Possui muitos 

recursos extras como imagens por camadas. Este formato é suportado por 

pouquíssimos programas fora o Adobe Photoshop. 

 

Existem muitos outros editores de imagens bitmap disponíveis, mas nenhum 

deles conseguiu a popularidade do Adobe Photoshop entre os profissionais. Os 

concorrentes mais utilizados noutros mercados-alvo são o GIMP open-source, 

já com muito utilizadores; e os pacotes de programas comerciais, como Corel 

Photo-Paint, PhotoFiltre e Paint Shop Pro. 

Entre outras alternativas menos conhecidas, pode-se destacar 

o GIMPshop (uma versão do GIMP com uma interface gráfica semelhante ao 

Photoshop), o paint.net, o Pixel32 disponível em mais plataformas do que os 

outros programas comerciais, o PhotoFiltre, excelente alternativa gratuita para 

uso não-comercial, e o PhotoScape que está fazendo um enorme sucesso pela 

sua facilidade de uso. 

 

Atualmente a versão mais recente é o Photoshop CC (Creative Cloud, 14.0), 

lançada em junho de 2013, essa versão não apresenta grandes evoluções 
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comparado a sua antecessora, porém ao comparar com a primeira versão o 

Photoshop 0.63 foram adicionadas muitas funcionalidades importantes como:  

Implementação de Paths que permite o desenho vetorial;  

Seleção de objetos mais precisa;  

Content-Aware: ferramenta que remove itens desejados baseando-se nos 

dados ao redor dele;  

Possibilidade de ver os pincéis em 3 Dimensões e ver como reagem com a 

pintura;  

Paletes tabuadas;  

Camadas ajustáveis;  

Tipo de Letras editáveis;  

Texto totalmente vetorial;  

O uso de filtros;  

Figuras geométricas vetoriais;  

Histograma em tempo-real;  

Incrementação do recurso de criação, edição e pintura de "objetos 3D". 

 

A Adobe também oferece uma versão mais simplificada do seu produto, 

chamada de Photoshop Elements, que apesar de não possuir grandes 

recursos, consegue obter bons resultados, o programa tem como público alvo 

os usuários domésticos. Para os usuários que querem editar fotos em seus 

dispositivos móveis a empresa fornece as versões Express, Fix e Lightroom. 

 

Instalação (Versão Trial) 

 

Para realizar a instalação será usado o Photoshop CS6 Master Collection, 

disponível no site da Adobe. Siga o passo a passo a seguir para realizar a 

instalação (na plataforma Windows).  

1. Faça o download do(s) arquivo(s) no site da Adobe e armazene em uma 

pasta, como mostra a figura 1.1, escolha conforme o seu sistema operacional. 



2. Após o download , execute o arquivo “MasterCollection_CS6_LS16.exe”. A a 

janela apresentada na figura 1.2 deve abrir, nela escolha o local onde será 

instalado o programa e então clique em “Avançar”, irá aparecer uma barra de 

progresso como na figura 1.3. 

3. Como o Photoshop é um software pago, após a conclusão da etapa 2, 

escolha a opção de “Avaliar”, como mostra na figura 1.4. Caso você tenha 

comprado o software, escolha a opção “Instalar”, onde será solicitado um 

número de série. 

4. Nessa etapa será apresentado o contrato de licença do software, como na 

figura 1.5, Caso concorde, clique no botão “Aceitar”, para seguir com a 

instalação. 

5. Nessa etapa será solicitado o ID de usuário da Adobe, caso não possua, crie 

um através do botão “Criar uma Adobe ID”. Se já possuir, preencha os campos 

necessários e aperte “Entrar”. 

6. Nessa etapa você deve escolher quais softwares você vai instalar. Como o 

foco deste tutorial é o Photoshop, marque a opção dele e clique em “Instalar”, 

na figura 1.7 mostra as opções já selecionadas. 

7. Espere a conclusão da instalação como apresenta a figura 1.8. 

8. Após a conclusão de todas as etapas anteriores, seu PhotoShop estará 

pronto para o uso. Agora basta clicar em “Fechar”, como na figura 1.9 e pronto. 

Quando você abre o Photoshop CS6, será apresenta sua tela inicial, Nesta tela 

estão dispostas diversas ferramentas. 

 

 



Na parte superior da tela, encontra-se a Barra de ferramentas. Nesta barra é 

possível realizar as funções básicas do programa, assim como gerenciar 

configurações gerais do mesmo. 

No lado direito encontram-se os Painéis do Photoshop, para abrir novos painéis 

basta ir em Windows e marcar aqueles que deseja exibir. 

 

 

 

 

Já no lado esquerdo do ambiente de trabalho aparecerá o Painel Ferramentas, 

algumas dessas ferramentas têm opções que aparecem na barra de opções 

sensíveis ao contexto. Essas ferramentas podem ser expandidas, 

apresentando suas derivadas, para isso basta clicar com o botão direito do 

mouse sobre o ícone. 

 

Extensões nativas 

 

Extensões nativas são utilizadas para salvar projetos em andamento ou 

quando se deseja salvar todas as informações da imagem criada, são feitas 

para suportar múltiplas camadas de todos os tipos existentes no Photoshop, 

como camadas de texto, camada de efeitos, etc. As opções nativas são:  



PSD: este tipo de arquivo suporta informações sobre qualquer 

arquivo/ferramenta photoshop de até 2GB, ideal quando se trabalha com 

pequenas imagens.  

PSB: semelhante ao PSD, porém suporta imagens de maior peso, sendo a 

escolha certa para projetos com mais de 2GB os quais se deseja manter a 

qualidade da imagem. A extensão PSB foi implementada na versão CS do 

Photoshop, portanto não é suportada em versões anteriores. 

 

Formatos de Impressão 

 

Tanto designers web quanto profissionais em criação de materiais impressos 

utilizam de diversos formatos diferentes de arquivos, para assim chegar em um 

resultado adequado para cada tipo de imagem que se deseja. O photoshop é 

compatível com várias extensões, sendo GIF, JPG, PNG, EPS, TIFF e PCX as 

mais utilizadas. 

Segue algumas dicas para uma boa escolha de extensões:  

GIF: é um formato pequeno de imagem, podendo conter apenas 256 cores, 

fazendo com que sejam utilizados apenas para gráficos ou imagens com 

poucas cores.  

JPG: é um formato bom para salvar imagens complexas, já que comporta 16 

milhões de cores, porém utiliza um algoritmo com perdas para a compactação 

da imagem, o que lhe faz pouco útil em casos em que se deseja salvar 100% 

das informações contidas na imagem.  

PNG: pode ser salvo com diversas profundidades de bits e utiliza um algoritmo 

de compressão sem perda, o que se torna útil para imagens que devem ser 

mantidas intactas, porém pode deixar o arquivo mais pesado. Além disso, esse 

formato permite salvar imagens com fundo transparente. 

EPS, TIFF, PCX: utilizados principalmente para imagens em alta resolução.  

PDF: utilizado para imagens que devem conter algum tipo de segurança contra 

alteração. 

 

Para mudar o formato da imagem que está sendo editada no Photoshop basta 

clicar no menu Arquivo > Salvar como. 

 



Irá abrir uma janela, onde se pode escolher o diretório em que a imagem será 

salva e a extensão que a mesma terá. Clicando no item Tipo são abertas as 

opções possíveis para salvar a imagem. 

As camadas são parte essencial no processo criativo no Adobe Photoshop, 

pois organizam de forma lógica os elementos e efeitos que utilizamos nas 

composições e são acessadas pelo painel “Camadas”. As funções para 

Camadas permite "empilhar" elementos dentro de uma composição de modo 

que seja possível ter um controle individual para cada camada aplicada em 

uma única imagem. Esse recurso revolucionou o modo de editar imagens 

digitalmente. A flexibilidade sem precedentes das funcionalidades para 

manipulação de imagens em camadas levou os usuários a uma experiência 

similar à arte tradicional, como nas mesas de animação, onde a sobreposição 

de folhas de acetato permitia editar partes específicas da composição, 

mantendo-as separadas. Como falado anteriormente, pode-se compreender o 

funcionamento das camadas no Photoshop, através de uma analogia a folhas 

de acetato. Imaginemos várias folhas de acetato empilhadas, cada uma com 

algum desenho diferente – provavelmente esta foi a grande inspiração para a 

criação do recurso. 

O Photoshop oferece inúmeros efeitos como sombra, brilho e texturas que 

alteram a aparência do conteúdo de uma camada. Os efeitos de camada são 

vinculados ao conteúdo. Ao mover ou editar o conteúdo da camada, os 

mesmos efeitos são aplicados no conteúdo modificado. Por exemplo, se uma 

sombra projetada for aplicada a uma camada de texto e, em seguida, um novo 

texto for adicionado, a sombra será adicionada automaticamente ao novo texto. 

O estilo de camada é um ou mais efeitos aplicados a ela ou a um grupo de 

camadas. Para aplicar estilos, usamos a caixa de diálogo Estilos de Camada, 

que pode ser aberto com dois cliques na camada, ou através do botão direito 

do mouse e “Opções de Mesclagem” (ou Blending Options). Entre as opções 

de estilo estão a "Sombra projetada" os "Brilhos interno e externo", efeito 

"Acetinado", aplicar uma "sobreposição de cor ou degradê", e muito mais. É 

possível combinar e adicionar múltiplos estilos em uma única camada do 

projeto. 

 

Ferramenta Mover (Shift+V) 

 

Com a ferramenta mover podem ser realizadas as operações de mover uma 

camada e duplicar uma camada, desde que elas não estejam bloqueadas.  



1. Para desbloquear uma camada é preciso dar dois cliques no cadeado que 

tem na camada, no canto direito e em seguida, clicar em “Ok", ou se disponível, 

no cadeado acima de todas as camadas. 

2. Para mover o conteúdo de uma camada basta selecionar a sua camada, 

segurar o com o botão esquerdo do mouse e arrastar para onde desejar. 

 

 

O Adobe Photoshop é um dos editores de imagens mais populares em todo o 

mundo, inclusive dentre os brasileiros. Para conhecer as ferramentas, os 

internautas podem baixar uma versão de testes grátis, que funciona por 30 

dias. A versão trial do CS6 está disponível para download no site oficial e para 

usar é necessário fazer um cadastro rápido com o ID da Adobe.  

 

Download e Instalação 

 

Passo 1. Acesse a página de downloads da Adobe (adobe.com/br/x-productkb/) 

para encontrar a versão CS6 do Photoshop, já que ela é mais antiga. Role a 

tela até a opção “Photoshop CS6″  e clique no link para baixar os dois arquivos 

com idioma em português (com 1,1 GB e 1 MB); 

 

Passo 2. Depois de baixar, encontre a pasta o arquivo mais leve, com 1 MB 

chamado de “Photoshop_13_LS4″ e clique duas vezes nele. O Photoshop 

começará a ser descompactado para instalação no computador. 

Passo 3. Ao descompactar será gerada uma pasta com o título de “Adobe CS6″ 

na área de trabalho. Selecione a subpasta “Adobe” e depois “Adobe CS6″. 

Complete clicando duas vezes no arquivo “Set-up.exe” para iniciar a instalação 

Passo 4. Clique no botão de “instalar uma versão de avaliação” (que é a trial de 

testes) e confirme em “Aceitar” 

Passo 5. Clique em “Entrar” caso o programa já identifique sua Adobe ID ou 

inscreva-se para acessar, adicionando os dados pessoais. 

Passo 6. Selecione a caixa de texto ao lado da versão do Photoshop que 

deseja instalar, confirme o idioma em português e clique em “instalar”. O 

procedimento pode demorar alguns minutos; ao final será mostrada uma 

mensagem de conclusão. Finalize no botão “fechar”. 

 

http://www.techtudo.com.br/tudo-sobre/adobe-photoshop.html
http://www.techtudo.com.br/tudo-sobre/adobe.html
https://helpx.adobe.com/br/x-productkb/policy-pricing/cs6-product-downloads.html


Photoshop CS6 

 

Passo 1. Ao abrir o Photoshop CS6 pela primeira vez será exibida uma tela 

com o tempo de trial para testes (30 dias). Clique no botão “Iniciar versão de 

avaliação” para começar a usar o programa 

 

Passo 2. O Photoshop é um programa completo para edição de imagens. Para 

entender a interface, no topo há uma barra para encontrar filtros, ajustes, salvar 

arquivos e tudo o que diz respeito à configurações 

 

 

 

Passo 3. Na lateral esquerda está a barra de ferramentas, para controlar os 

itens adicionados na edição. Assim, é possível arrastar imagens, aplicar cores, 

textos, recortar a foto, remover o fundo e mais recursos. 

 

 



Passo 4. Na lateral direita estão as layers (ou camadas) e tudo o que for 

adicionado durante a edição aparecerá nesta janela. No topo direito há atalhos 

para ajustes de brilho, contraste, cor e efeitos 

 

 

Passo 5. Para facilitar o uso, estão disponíveis estilos para cada atividade, que 

mostram as ferramentas em atalhos. Para acessar, clique no menu no topo 

direito da tela. Há opção para pintura, 3D, movimento, tipografia e até itens 

para personalizar.  

O Photoshop é uma ferramenta incrivelmente poderosa, mas não dá pra negar 

que ela bota medo em quem nunca usou. Se você sempre quis aprender a usar 

Photoshop, mas não sabia por onde começar, seja bem vindo. O vídeo acima é 

a sua aula. Ele é longo se considerarmos que está na internet, mas é curto se 

considerarmos todos os tópicos que ele cobre. 

 



Nós não vamos ver todas as ferramentas individualmente, mas boa parte delas 

estão abaixo. Este resumo vai te dar uma boa ideia do que cada uma faz, mas 

não deixe de encontrar alguma foto e usá-las na prática. 

 

Mover (Atalho: V) 

 

A ferramenta Mover permite que você mova objetos em uma determinada 

camada. Para usá-la, clique em qualquer lugar da tela e arraste. O objeto 

selecionado se moverá na camada. 

Letreiro (Atalho: M) 

 

A ferramenta Letreiro tem uma tradução esquisita. Uma tradução muito melhor, 

na minha opinião, seria “Seleção por Área”. De qualquer forma, ela serve para 

selecionar uma porção da tela no formato retangular ou elíptico. A seleção é a 

parte da imagem que será afetada por qualquer edição que você fizer 

posteriormente. Segurando Shift ao fazer a seleção, você obtém um quadrado 

ou círculo perfeito. 

 

Laço (Atalho: L) 

 

O Laço é uma ferramenta de seleção livre que permite a você desenhar uma 

área de seleção com o mouse, enquanto mantém o clique pressionado. Ao 

fechar a forma, tudo que estiver dentro dela, estará selecionado. Dentro desta 

mesma ferramenta você ainda tem acesso ao Laço Poligonal, que permite criar 

http://www.flickr.com/creativecommons/by-2.0/
http://www.gizmodo.com.br/files/2011/02/01-move-tool.jpg
http://www.gizmodo.com.br/files/2011/02/02-selection-tools.jpg
http://www.gizmodo.com.br/files/2011/02/03-lasso.jpg


uma seleção livre em vários cliques, e o Laço Magnético, que tenta detectar 

bordas automaticamente para facilitar a sua seleção. 

 

Varinha Mágica (Atalho: W) 

 

A Varinha Mágica é mais uma ferramenta de seleção. Ao selecioná-la e clicar 

em uma área da imagem, você diz ao Photoshop que deseja uma seleção que 

inclua o ponto clicado e todas as áreas adjacentes com coloração similar (há 

um ajuste no topo da tela para determinar a sensibilidade dessa medição de 

área similar). A Varinha Mágica é geralmente utilizada como uma forma 

amadora de retirar fundos de imagens. 

. 

Corte (Atalho: C) 

 

A ferramenta de Corte é usada para – surpresa! – cortar as suas imagens. 

Você faz uma seleção retangular, e tudo que ficar de fora dessa seleção será 

eliminado da imagem. É possível especificar o tamanho exato do corte, ou uma 

proporção, assim como cortar à mão livre. 

 

Conta-gotas (Atalho: I) 

 

A ferramenta Conta-gotas permite que você clique em qualquer parte da tela 

para copiar a cor do local clicado. Ao copiar a cor, o Conta-gotas alterará a cor 

primária que você estiver usando para a cor copiada. Esta ferramenta facilita 

http://www.gizmodo.com.br/files/2011/02/04-magic-wand.jpg
http://www.gizmodo.com.br/files/2011/02/05-crop-tool.jpg
http://www.gizmodo.com.br/files/2011/02/06-eyedropper-tool.jpg


enormemente na hora de escolher uma cor exata que já exista na imagem, em 

vez de ter que escolher no seletor de cores. 

. 

Pincel de Recuperação: (Atalho: J) 

 

O Pincel de Recuperação deixa você pegar uma amostra de um ponto da 

imagem e usá-lo para pintar sobre outro ponto dela. Quando você terminar, o 

Photoshop vai examinar a região ao redor da que você pintou para tentar 

suavizar a sua edição. 

 

 

Pincel e Lápis (Atalho: B) 

 

O Pincel e o Lápis são ferramentas de desenho que atuam como os seus 

nomes sugerem. O lápis cria uma linha dura de espessura variável, enquanto o 

pincel pode assumir centenas de formatos formatos e modelos diferentes, e 

geralmente produz uma linha mas suave. 

. 

Carimbo (Atalho: S) 

 

Como o Pincel de Recuperação, o Carimbo permite que você determine uma 

parte da imagem como origem de amostragem e então use esta amostragem 

para cobrir outra área. No entanto, com o Carimbo a coisa para por aí. O 

Photoshop não fará nada para suavizar a sua correção. 

http://www.gizmodo.com.br/files/2011/02/07-healing-brush.jpg
http://www.gizmodo.com.br/files/2011/02/08-paintrbrush-and-pencil.jpg
http://www.gizmodo.com.br/files/2011/02/09-clone-stamp.jpg


Pincel do Histórico (Atalho: Y) 

 

O Pincel de Histórico permite que você “pinte o passado”. O Photoshop salva 

todas as etapas da sua edição (bem, por padrão são apenas 50 etapas), e o 

Pincel de Histórico é capaz de pintar o passado sobre a imagem atual. 

Digamos que você aumentou o brilho da imagem inteira, mas gostaria que um 

pedaço dela voltasse a ficar escuro como estava antes. Nesse caso, você pode 

selecionar o Pincel do Histórico e a etapa do histórico que representa a 

imagem como você quer que ela volte a ser, então pintar a parte desejada para 

trazer de volta a forma antiga. 

 

. 

Borracha (Atalho: E) 

 

A Borracha é uma ferramenta praticamente idêntica ao pincel, com a vital 

diferença de que ela apaga em vez de pintar. Ao apagar, pode acontecer da 

região apagada adquirir uma cor “estranha”. Isso se dá porque a Borracha 

preenche o plano de fundo da área apagada com a cor de plano de fundo 

selecionada (ver “Ferramentas de Seleção de Cor” abaixo). 

 

Lata de Tinta e Gradiente (Atalho: G) 

 

A Lata de Tinta funciona da mesma maneira que a Varinha Mágica, no sentido 

de que atua sobre a área clicada e as áreas similares ao redor, mas, em vez de 

selecionar, ela pinta com a cor primária ativa. A ferramenta Gradiente pega as 

http://www.gizmodo.com.br/files/2011/02/10-history-brush.jpg
http://www.gizmodo.com.br/files/2011/02/11-eraser.jpg
http://www.gizmodo.com.br/files/2011/02/12-paintcan.jpg


cores primárias e de fundo ativas e clica um gradiente entre elas, mas também 

pode ser usada para criação de gradientes bem mais complexos, envolvendo 

transparências e mais de duas cores. 

 

Desfoque, Nitidez e Borrar (Atalho: nenhum) 

 

Estas três ferramentas funcionam como pincéis, mas cada uma tem um 

impacto diferente na sua imagem, bastante auto-explicativos. A ferramenta 

Borrar é muito útil para em desenhos, para fazer cores com transições suaves 

ou para fazer elementos como fumaça. 

 

Subexposição, Superexposição e Esponja (Atalho: O) 

 

Estas são mais alguns exemplos de ferramentas do tipo pincel, que manipulam 

luminosidade e intensidade de cores. A primeira serve para escurecer áreas da 

foto, enquanto a segunda serve para clarear, e a terceira serve para saturar ou 

suavizar cores na área pintada por ela. São ferramentas muito úteis para 

retoques em fotos. 

 

Caneta (Atalho: P) 

 

http://www.gizmodo.com.br/files/2011/02/13-blur_-sharpen_-and-smudge.jpg
http://www.gizmodo.com.br/files/2011/02/14-burn_-dodge_-and-sponge.jpg
http://www.gizmodo.com.br/files/2011/02/15-pen.jpg


A ferramenta Caneta é usada para desenhar gráficos vetoriais. Também pode 

ser usada para criar demarcadores que podem ser usados para várias tarefas 

mais avançadas. 

 

 

Ferramenta Texto (Atalho: T) 

 

Com esta ferramenta, você pode escrever horizontalmente. Com as 

ferramentas escondidas abaixo desta, você consegue escrever verticalmente e 

também criar máscarasde texto horizontais e verticais. 

 

 

Seleção de Demarcador (Atalho: A) 

 

Esta ferramenta permite mover qualquer demarcador criado. É igual à 

ferramenta Mover, mas apenas para demarcadores. 

 

 

Formas (Atalho: U) 

Estas quatro ferramentas permite criar retângulos, elipses, polígonos, linhas e 

formas personalizadas em formato vetor. Estas formas são muito úteis quando 

se está desenhando ou criando máscaras geométricas para fotos. 

http://pt.wikipedia.org/wiki/Desenho_vetorial
http://www.digitalscrapbookplace.com/university/tutorials/ps_layermasks.shtml
http://www.gizmodo.com.br/files/2011/02/16-type.jpg
http://www.gizmodo.com.br/files/2011/02/17-path-tool.jpg
http://www.gizmodo.com.br/files/2011/02/18-shape-tool.jpg


Ferramenta Mão (Atalho: H) 

 

Esta ferramenta permite mover a sua visão da área de trabalho inteira do 

Photoshop. Se a imagem que você está trabalhando cabe inteira na tela do seu 

computador, esta ferramenta não serve para nada. Ela é útil para mover a sua 

visão quando você está trabalhando em uma imagem super aproximada com a 

ferramenta Zoom. Dica: a Mão pode ser selecionada temporariamente 

segurando a tecla Espaço. Quando você soltar o Espaço, estará novamente 

com a ferramenta anterior selecionada.) 

 

Zoom (Atalho: Z) 

 

A ferramenta Zoom é usada para aproximar e afastar a imagem, afim de 

trabalhar diretamente nos pixels individuais ou em uma pequena área. Por 

padrão, a ferramenta Zoom só aproxima. Para afastar, clique com a tecla 

Option/Alt. Ou use a roda do mouse para afastar e aproximar mais 

rapidamente. 

 

 

http://www.gizmodo.com.br/files/2011/02/20-hand-tool.jpg
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Ferramentas de Seleção de Cor (Teclado: D para padrões, X para inverter as 

cores) 

Estas ferramentas permitem escolher e gerenciar as cores que você está 

usando. A cor de cima é a sua primária, enquanto a de trás é a cor de plano de 

fundo. A cor primária é a que será usada pelos pincéis. A cor de plano de fundo 

entra em ação quando você deletar ou extender algo do plano de fundo (apesar 

de que agora, no Photoshop CS5, é possível usar a cor primária em algumas 

circunstâncias. Os dois ícones menores acima das cores são atalhos de 

funções. O da esquerda, que mostra um quadrado preto sobre um branco, 

configura as suas cores primária e de plano de fundo para os padrões, que são 

preto e branco (você também pode usar o atalho D). A seta curva com duas 

pontas à direita troca as suas cores uma pela outra (atalho: X). Clicar em 

qualquer uma das cores abre um seletor para que você escolha com precisão a 

cor que quer usar agora. 

O layout do Photoshop por exemplo vem mantendo sua base desde sua 

primeira versão, justamente para não confundir muito os usuários. 

Uma prova real desta base é a barra de ferramentas que fica localizado no lado 

esquerdo. 

Observe como estas barras conservam uma sequência do seu layout a cada 

nova versão, até mesmo quando uma nova ferramenta é adicionada ou 

retirada. 

 

 



 

 

A interface do Photoshop 

 

O Photoshop CC 2017 trouxe mudanças interessantes nesta nova versão, 

principalmente na tela principal, onde o usuário agora pode visualizar as 

últimas imagens que foram abertas no aplicativo, assim como botões 

de Criar e Abrir novos documentos. 

Existe a opção de organizar estas últimas imagens abertas 

por: Nome, Tamanho, Aberto pela última vez ou Tipo. 

Outro ponto de destaque é a opção de visualização destas imagens. Você 

escolhe se deseja ver em lista ou miniaturas. 

 

Barra de controle 

 

Em uma visão rápida, a barra de ferramentas oferece 65 opções de 

ferramentas para o usuário trabalhar em suas fotos. 



Ao ativar qualquer uma destas ferramentas, você vai visualizar que uma barra 

na interface do Photoshop vai ficar mudando. 

Esta barra em especial é chamada de: Barra de controle. 

Sua finalidade é apresentar recursos extras das ferramentas selecionadas. 

Vejamos um exemplo: 

Ao ativar a ferramenta Letreiro retangular eu sei que posso fazer uma seleção 

em qualquer área da imagem em formato quadrado. 

Até este ponto não tem nada de estranho. 

A função da barra de controle passa a fazer sentido quando dentro de uma 

seleção já criada ocorre a necessidade de fazer uma nova seleção. 

Para que esta ação ocorra é necessário ativar na barra de controle uma função 

extra da ferramenta Letreiro Retangular chamada Adicionar à seleção para que 

o usuário possa realizar o trabalho. 

 

Paletas 

 

As paletas são os painéis que você vê na parte direita da tela. Eles facilitam 

ações como navegar pela imagem, fazer alguns ajustes, alternar entre modos e 

outras coisas muito úteis. Se quiser se livrar de alguma que considere 

desnecessária, ou principalmente trazer uma paleta que não esteja 

aparecendo, use o Menu Janelas, e, se for necessário, arraste com o mouse 

para a área de paletas à direita. 

 

Camadas 

 

A paleta de camadas é provavelmente o coração da edição de imagens. Ela 

mostra todas as diferentes camadas do seu documento, na ordem. Você vai 

usar esta paleta mais do que qualquer outra. Nela você vai organizar e ordenar 

as suas camadas, assim como configurar modos de mistura, visibilidade e 

opacidade, agrupar e fundi-las umas com as outras, além de uma porção de 

coisas mais avançadas. 

http://en.wikipedia.org/wiki/Blend_modes
http://www.gizmodo.com.br/files/2011/02/p01-layers_01.png


Ajustes 

 

O painel de ajustes é onde você pode facilmente criar e editar camadas de 

ajustes. Estas camadas de ajustes são alterações não-destrutivas que afetam 

todas as camadas abaixo delas e que podem ser facilmente ligadas ou 

desligadas. O seu uso mais comum é para correção de cores (especificamente 

os ajustes de Níveis e Curvas), mas há muitos ajustes diferentes que você 

pode fazer para alterar dramaticamente o visual da sua imagem. 

 

Canais de Cores 

 

A paleta de Canais de Cores permite analisar de modo separado as diferentes 

cores que formam a sua imagem. Se você estiver em modo RGB, terá os 

canais vermelho (R), verde (G) e azul (B). Estes canais vão se modificar se 

você estiver usando um espaço de cores diferente, como CMYK ou LAB. 

Quando você escolher uma cor específica, vai notar que a sua imagem será 

mostrada em diferentes versões de preto e branco. Isso é porque cada canal 

de cor é apenas uma imagem monocromática representando a luz em cada 

canal (ou seja: o canal vermelho mostra apenas a quantidade de luz vermelha 

que a imagem emite nos diferentes pontos dela). Alternar entre esses canais 

diferentes é útil para fazer retoques específicos em cada canal de cor, 

melhorias gerais de contraste e também para converter a sua foto para uma 

versão preto e branco de modo mais correto. 

 

Seletor de Cores 

http://en.wikipedia.org/wiki/Cmyk
http://en.wikipedia.org/wiki/Lab_color
http://www.gizmodo.com.br/files/2011/02/p02-adjustments.png
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Esta paleta permite alterar suas cores primária e de plano de fundo de maneira 

mais fácil, usando comandos deslizantes com os valores individuais RGB (ou 

do espaço de cor que você estiver utilizando). 

 

Amostras de Cores 

 

A paleta de amostras de cores é um conjunto de cores pré-definidas que você 

pode escolher rapidamente. É possível carregar diversas outras coleções de 

amostras, ou criar a sua própria. 

 

Histórico 

 

A paleta de histórico permite ver as últimas etapas da sua edicão, e retornar a 

alguma delas caso você queira. O comando Desfazer (Ctrl+Z) tem como 

padrão apenas alternar entre o último e o penúltimo estado do histórico. Para 

voltar mais etapas, é por aqui que você chega lá (até o máximo de 50 ações, 

por padrão). 

 

Texto 

 

A paleta de Texto, e a sua companheira Parágrafo, permitem fazer todo o tipo 

de ajuste necessário às suas camadas de texto. Estas opções são bem 

similares às que você encontra em um editor de texto como o Word, mas você 

também pode especificar coisas como espaçamento entre letras e entre linhas, 

http://www.gizmodo.com.br/files/2011/02/p05-color-swatches.png
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assim como largura relativa dos caracteres, que são ajustes mais úteis no 

mundo do design. 

 

Menus 

 

 

Muito do que você encontra nos menus do Photoshop pode ser feito com as 

ferramentas que já vimos. Ainda assim, vamos dar uma olhada rápida das 

principais opções de cada menu. 

Arquivo 

Como de costume, o menu Arquivo lida com abrir, salvar e fechar arquivos. 

Uma opção diferente e de destaque é a Salvar Para Web, que é muito útil para 

a função indicada pelo próprio nome. 

Editar 

Outro menu que previsivelmente funciona como em muitos outros programas, o 

Editar traz recursos como desfazer, refazer, cortar, copiar e colar. No 

Photoshop, é aqui que você transforma suas camadas e define seu espaço de 

cores. 

Imagem 

Ajustes de imagem e de tela, incluindo efeitos destrutivos que você também 

pode encontrar na paleta Ajustes. As opções neste menu são feitas para alterar 

a sua imagem como um todo, apesar de alguns ajustes serem aplicados 

apenas a uma camada. 

Camada 

O menu Camada permite fazer todo tipo de coisa que você faria pela paleta 

Camadas, com algumas opções extras. Este menu também permite a criação 

http://www.gizmodo.com.br/files/2011/02/menus.jpg


de camadas de ajuste e objetos inteligentes (um grupo de camadas tratado 

como um objeto único). 

Selecionar 

As ferramentas Letreiro e Laço serão seus principais meios de selecionar 

partes da sua imagem, mas o menu Selecionar ajuda a refinar a sua seleção. 

Também pode ser usado para criar seleções completamente novas a partir de 

critérios como espectro de cor e luminosidade. 

Filtro 

O menu Filtro traz uma coleção de filtros inclusos no Photoshop (é possível 

instalar mais filtros de terceiros), que podem borrar, focar, distorcer e alterar a 

sua imagem (ou algumas camadas apenas) de muitos modos diferentes e 

únicos. A melhor maneira de conhecer os filtros é experimentá-los todos. Isso 

pode tomar um pouco de tempo, mas é divertido brincar com eles e ver o que 

conseguem fazer. 

Análise 

Aqui você encontra ferramentas de medição. Haverá ocasiões em que você 

precisará delas para fazer alterações precisas em suas imagens, mas isso tudo 

é Photoshop avançado. 

3D 

Assim como o menu anterior, este aqui contém controles para manipulação de 

objetos 3D que são avançados o bastante para que não valha a pena entrar 

nos seus méritos. No entanto, encorajamos você a experimentar com eles e 

aprender o que puder. 

Visualizar 

Este menu oferece diversas opções de visualização da sua área de trabalho. É 

possível exibir ou esconder guias e réguas e fazer com que o Photoshop 

automaticamente alinhe objetos em relação a bordas, cantos e ou uma grade 

no plano de fundo. A exibição desta grade também pode ser ligada e desligada 

neste menu. 

Janela 

O menu Janela permite esconder e mostrar certas janelas e paletas. Você 

também pode organizar as suas janelas do Photoshop do jeito que quiser, e 

salvar a sua organização para carregar posteriormente. E isso é tudo que você 

precisa saber sobre o básico do Photoshop. 

 



Duplique a camada da imagem (ctrl+j) 

vá em menu superior > filtro > desfoque(Blur) > Desfoque 

graussiano(Graussian Blur) Ajuste para  10px a 15px de ok! 

Vá em modos de mesclagem e selecione Sobrepor(Overlay). Se ficar muito 

forte ajuste a opacidade para em torno de 80%. 

 

 

Super simples mais com efeito de impacto e perfeito para restaurar a cor. 

Nessa técnica o que fará você se diferenciar de um amador é saber dosar a 

opacidade da camada. 

Variações da ferramenta pincel de recuperação de manchas [healing brush] 

 

 

 

copiar a área ao redor (automático) 

copiar a partir de uma área que eu selecionei- click a tecla ALT sobre a area 

que voce quer, depois solte e use normalmente a ferramenta. 

Versão para usar em regiões maiores, como se fosse a ferramenta seleção. 

Sensível ao conteúdo ou seja sensível ao que estiver em qualquer um dos 

lados do pincel. 

Remover olhos vermelhos- ajuste o tamanho do pincel, para ser igual ao 

tamanho do olho e de um click em cima. 

 

Habilidades: 

Como retocar pele photoshop com efeito natural e sem deixa a modelo com 

cara de boneca! 

Como usar efeito Dodge(Subexposição) e Burn(Superexposição) do 

photoshop. 

http://www.patricialira.com/wp-content/uploads/2017/06/varia%C3%A7%C3%B5es03.jpg


Como usar a ferramenta esponja do photoshop. 

Aplicação correta desses efeitos em fotografias para retocar pele photoshop. 

Passo 01– Remover as impurezas e limpar a imagem com ferramenta pincel de 

recuperação para remover espinhas cravos, olheiras e manchas no geral. Essa 

vai sei nossa base para começar o retoque, eu já expliquei no tutorial 02 Como 

remover espinhas montanhas e outras coisas, tudo sobre essa ferramenta caso 

você não a conheça é só assistir o tutorial anterior. 

 

 

 

Passo 02- Equilibrar a luz e sombra com Dodge e Burn realçando as áreas de 

luz e sombra da modelo. Esse passo é muito importante para restaurar 

detalhes como sobrancelha falhadas, luz dos olhos e outros detalhes da foto. E 

vá delicadamente restaurando as sombras e luzes do rosto. 

 

Photoshop 

 

A ferramenta: Dodge ou Subexposição  

Ela é um pincel que cria literalmente um spot de luz, ao nosso dispor para 

iluminarmos todos as áreas que quisermos! Isso mesmo ela adiciona luz!. No 

entanto temos que ter cuidado, que por ela ser baseada na exposição de luz o 

excesso dela causa intensa saturação na foto por isso eu indico o uso com 

exposição a 20% no máximo. 

 

A ferramenta: Burn ou Superexposição  

Já a ferramenta Burn faz exatamente o contrario, enquanto o Dodge cria 

literalmente um spot de luz, o burn cria efeito de escuridão! No entanto também 

temos que ter cuidado, por ela ser baseada na luz também o excesso dela 

causa desaturação extrema na foto por isso eu indico o uso com exposição a 

20% no máximo também. 

 



Dica de Ouro  

O mais importante ao usar essa técnica é paciência e leveza, não adianta 

querer fazer tudo correndo que não vai funcionar! Faça com a opacidade baixa 

sempre que não tem erro. 

 

Passo a passo: 

Passo 01: Use a ferramenta conta gotas (alt) para selecionar cor exata do 

dente. 

 

Passo 02- Use a ferramenta pincel e pinte sobre o aparelho. 

Passo 03- Para clarear use a ferramenta esponja e passe apenas na area do 

dente. 

Passo a passo: 

Passo 01: Recorte a foto com a ferramenta a ferramenta caneta, porque ela é 

mais precisa e isso fará toda diferença. Selecione a ferramenta e vá clicando 

ponto a ponto em torno da modelo bem rente ao corpo. Depois clique com o 

esquerdo e vá em criar seleção de ok. E de ctrl+j para duplicar e o recorte está 

pronto.  

 

Passo 02- Use a ferramenta dissolver(ou liquify se seu photoshop for inglês) e 

vá com delicadeza afinando os braços, e trabalhando as curvas da cintura sem 

exagerar d+ para não parecer falso. Tente transforma-la em uma modelo plus 

size linda por exemplo em vez de uma modelo de passarela 

Passo 03- Use o pincel de recuperação e elimine todas as áreas flácidas da 

modelo. 

Passo 04- Use o Dodge(Subexposição) e Burn(Superexposição) para restaurar 

as sombras e luzes. Quando fazemos retoques grandes assim é sempre bom 

dar uma retocada na iluminação até porque a ferramenta dissolver é bem 

drástica e pra destruir a iluminação com ela é muito fácil! 

Então use o esses pinceis próprios de iluminação para realçar áreas de sombra 

e luz, sempre com a opacidade a 20px no máximo. 

Ferramenta: Dissolver (Liquify) do photoshop  

A ferramenta Dissolver foi criada para nos dar liberdade para distorcer, 

transformar, alargar ou achatar qualquer imagem, e até reconstruir partes da 

https://youtu.be/QYxpWC3Dzmo


foto distorcida nenhum outro software tem uma ferramenta capaz de criar 

distorções extremas assim! Por isso ela ficou bem famosa no mundo inteiro e 

principalmente no mundo das capas de revista! Por edições mal feitas e 

grosseiras. É como dizem poder em mãos erradas é destruição 

Concentre-se em usar a ferramenta dissolver para criar simetria na foto, se um 

braço está gordo por exemplo não tente deixar ele como o da gisele Bündchen. 

Procure apenas deixa-lo reto só isso já da outra impressão para a foto então 

amelhor dica que eu posso te dar é tente criar simetria em vez de milagre 

O retoque completo – Retoque de pele + Retoque de luz + Retoque de cor. 

Tratamento de foto  + Make no photoshop com ar natural e realista? Será 

possível? 

Eis um grande dilema para os photoshopers, com as infinitas possibilidades do 

photoshop é dificil escolher uma tecnica que seja rápida e menos destrutiva 

para realçar as qualidades da nossa modelo 

 

Habilidades: 

Técnica de colorização usando camadas e efeitos de modos de mesclagem. 

Tratamento de foto: Técnica de iluminação. 

Dica especial de iluminação não destrutiva. 

Make profissional no photoshop. 

 

Passo a passo: 

Passo 01 Tirando as espinhas: Use a ferramenta Pincel de recuperação no 

photoshop no modo automático para remover machinhas, espinhas ou 

qualquer outro detalhe ruim na foto. 

Passo 02 Luz e Sombras- Use a ferramenta Dodge(Subexposição) e 

Burn(Superexposição) para realçar as sombras e luzes, com a exposição a 

15% lembrando que dodge é luz, e Burn é escuridão. 

Passo 03 Cor na restauração-  Use o pincel com opacidade entre 15px a 20px 

para corrigir a iluminação nas áreas de saturação. Selecione a cor da area de 

luz e pinte delicadamente sobre ela e vice versa com areas escuras. porque 

como é cor não vai saturar ainda mais a aquelas areas que já estão saturadas 

Passo 04 Colorização –  Ainda com o brush crie uma nova 

camada(Shift+ctrl+n) e com ajuda de uma referencia pinte a sombra, se quiser 



dar mais vida para a cor use modo de mesclagem “Sobrepor” (Overlay) e de 

toques de cor no centro da sombra e use o modo multiplicar(multiplay) para 

enfatizar as sombras, sempre de leve e se você sentir que exagerou diminua a 

opacidade da camada para obter um efeito suave. 

 

As camadas no Photoshop permitem que qualquer pessoa possa editar uma 

foto construindo a imagem em diversas seções de camadas. 

Para você entender melhor, observe a figura abaixo, onde uma camada 

principal foi duplicada três vezes, gerando automaticamente três novas 

camadas em separado. 

Este processo ajuda o profissional trabalhar individualmente em cada camada. 

Um bom exemplo desta independência de cada camada é o interesse do 

usuário em adicionar um brilho externo. 

Para realizar esta ação você deve seguir estes passos: 

Passo 1: Selecionar uma das três camadas duplicadas. 

Passo 2: Clicar duas vezes nesta camada selecionada para abrir a caixa de 

diálogo de Estilo de Camada. 

Passo 3: Escolher a opção Brilho Externo e dentro da área 

chamado Estrutura escolher uma cor de preenchimento. 

Realizado este processo clique no botão OK. 

 

DICA: Nunca se esqueça de nomear suas camadas. Tomando esta iniciativa, 

você se mantém organizado e o ajudará quando estiver trabalhando em um 

grande projeto com muitas camadas. 

Ferramenta Mover 

Esta é uma das ferramentas que você vai usar com maior frequência no 

Photoshop. 

Com ela você pode executar várias funções, como mover o conteúdo de uma 

camada, mover diretamente camadas de um documento para outro, copiar 

camadas, aplicar transformações, selecionar e alinhar diversas camadas. 

Em resumo é uma ferramenta de movimento, transformação e alinhamento. 

DICA: A tecla de atalho desta ferramenta é “V”. 



Painel de Cores 

Em se tratando de Photoshop é natural que todo usuário tenha o interesse de 

usar, modificar, copiar e salvas cores personalizadas em seus projetos. 

Por padrão na área de trabalho Essencial o painel cores fica localizado no lado 

direito da sua tela na parte superior. 

Outro local para encontrar as opções de cores e muito usada por boa parte dos 

usuários que já estão habituados no Photoshop é na parte inferior da barra de 

ferramentas à esquerda, indicadas por duas caixas sobrepostas. 

 

Ferramenta Corte Demarcado 

É comum fazer algum tipo de corte para chamar mais a atenção para o tema 

de uma foto. 

Esta ferramenta em especial tem evoluído consideravelmente desde a versão 

CS5. Em sua versão atual (CC 2017) ela dispõe de opções que ajudam 

bastante o usuário a criar o corte ideal para seus projetos. 

 

Objeto Inteligente 

Descoberto por fotógrafos, começou sutilmente a receber melhorias ao longo 

dos últimos anos, se tornando uma das mais poderosas ferramentas do 

Photoshop. 

Um dos seus principais pontos positivos esta na capacidade de permitir ao 

usuário trabalhar de forma não destrutiva em suas imagens, assim como nos 

filtros que também são aplicados nestas imagens. 

A Adobe diz que objeto inteligente é uma camada especial que pode conter 

com tamanha intensidade informações de imagens ou vetores, preservando 

sempre o conteúdo original e todas as suas características. 

Em outras palavras, o objeto inteligente permite que o usuário possa realizar 

edições não destrutivas no conteúdo original. Com este recurso aplicado, você 

pode criar praticamente qualquer ideia dentro do Photoshop. 

 

1. Rotacione a visualização  

Em muitos casos, ver a imagem em um outro ângulo pode ajudar. É possível 

fazer isso sem rotacionar o conteúdo em si, mas sim sua tela. Pressione R no 

teclado para ativar o recurso. 

http://www.mrccursos.com/blog/objeto-inteligente-uma-das-mais-poderosas-ferramentas-do-photoshop
http://www.mrccursos.com/blog/objeto-inteligente-uma-das-mais-poderosas-ferramentas-do-photoshop


 

2. Edite camadas de texto simultaneamente  

Você não precisa editar uma camada de texto de cada vez no Photoshop. 

Selecione todas e use a barra lateral de camadas no lado direito para editar 

todas ao mesmo tempo. 

 

3. Seleções mais precisas  

Usando o botão espaço do teclado, quando selecionar algum conteúdo com a 

ferramenta de seleção, você poderá movê-la pela tela. Isso facilita para não ter 

que remover a seleção e fazer de novo, em caso de um erro. 

 

4. Veja uma camada sozinha  

Para ver só uma camada e desativar todas as outras, basta pressionar Alt e 

clicar no “olhinho” do lado da camada que você deseja ver. 

 

5. Mova seleções entre abas  

Se quer mover a seleção de alguma imagem de uma aba para outra do 

programa, pode arrastar o mouse de uma para outra. Um processo bem mais 

simples do que criar uma camada, copiar e colar. 

 

6. Cole no local exato  

Ainda sobre “interação” de imagens, se quiser manter algo copiado de uma 

imagem para a outra, pressione Shift quando for fazer o Ctrl + C e Ctrl + V. 

Assim, o conteúdo será colado no destino exatamente na posição que estava 

de onde saiu. 

 

7. Salve arquivos mais rápido  

Desativar a compressão de imagens pode fazer com que você ganhe tempo. 

Vá em Preferences, File Handling, e marque Disable Compression of PSD and 

PSB files. 

 

8. Caneta Magnética  

http://www.techtudo.com.br/tudo-sobre/adobe-photoshop.html


O laço magnético facilita a seleção de conteúdo em casos, por exemplo, de 

recorte de imagens. Para usar a caneta magnética: selecione sua ferramenta 

comum de Freeform Pen Tool e depois em Magnetic para ativar. 

 

9. Corrigir Imagem Rapidamente  

Use a Régua, trace uma linha horizontal e outro ponto de referência. Selecione 

Image, Image Rotation e Arbitrary, e o Photoshop identifica certinho qual é o 

posicionamento correto da imagem de acordo com as coordenadas. 

 

10. Remova Granulado  

Às vezes, você fica com um granulado em imagens quando cola as mesmas 

em outras camadas. Vá na opção Matting e depois acesse o menu Layer para 

acessar uma série de recursos que pode ajudar a removê-lo. 

 

11. Remova Reflexos  

Uma nova ferramenta chamada Dehaze foi adicionada ao menu de efeitos. Vá 

em Filter, Camera Raw Filter, abra o menu Effects e selecione-a para ajudar a 

remover reflexos em fotos de paisagens, por exemplo. 

 

12. Borre  

Borrar imagens nem sempre é ruim, e pode fazê-lo sem perder qualidade ou 

realismo. Vá ao menu Filter, selecione Blur e veja todas as opções de borrar 

que estão lá. Alguma delas pode lhe ajudar. 

 

13. Lorem Ipsum  

Se você quer usar o Photoshop para fazer layouts e não quer perder tempo 

escrevendo qualquer coisa para simular texto, selecione a caixa de texto, vá 

em “Type” e em Paste Lorem Ipsum para preencher a caixa com um texto 

padrão. 

 

14. Exporte camadas  

http://www.techtudo.com.br/tudo-sobre/adobe-photoshop.html


Clique com o botão direito em cima de uma camada no menu de Layers, 

selecione Preferences e Export para definir o formato preferido e fazer sua 

exportação de uma determinada camada da sua imagem. 

 

15. Qualquer imagem como Brush  

Os brushes são uma maneira fácil de trabalhar no Photoshop para dar efeitos 

legais a fotos. E você pode transformar qualquer imagem facilmente em brush. 

Selecione a camada, vá em Edit e depois Define Brush Preset. 

 

16. Preview de Fontes  

O Photoshop permite que você vá testando as fontes em uma camada de texto. 

É só selecioná-la, selecionar o texto e ir na barra de fontes. Lá, use as setinhas 

para cima/baixo no teclado e as letras vão mudando no texto. 

 

17. Mais Desfazer  

O recurso Desfazer do Photoshop é importante em trabalhos longos. Porém, o 

limite de “lembrar” o histórico pode ser pequeno. Se você quiser aumentar, é só 

ir em Edit, Preferences, Performance e definir em History States. 

 

18. Brushes Precisos  

Edit, Preferences, Cursors. Este caminho permite que você defina o formato do 

cursor para usar em diversas situações. Pode ajudar, por exemplo, a tornar o 

uso de brushes mais preciso. 

 

19. Autocorreções  

Há três opções de autocorreções no menu Image: Tone (Tom), Contrast 

(Contraste) e Color (Cor). Se você não entende muito de mexer nestas 

propriedades, use para ver se sua imagem fica melhor. 

 

20. Barras de Ferramentas  



Sua experiência no Photoshop pode ser personalizada com as barras de 

ferramentas que você achar ideal. Vá em “Window” e selecione o que desejar 

que apareça na sua navegação; isso ajuda bastante. 

 

Tratamento de Fotografia 

 

Esta é uma técnica de tratamento de fotografia muito famosa e bonita que 

geralmente é utilizada em Portraits – fotografias onde o foco principal é a 

expressão facial. 

 

Existem diversas maneiras de fazer este efeito, cabendo, portanto, ao gosto e 

tempo do designer para fazer detalhes. 

 

O interessante deste tutorial não é decorar os caminhos e sim compreender a 

função das ferramentas, pois desta maneira você, designer, poderá fazer seus 

próprios efeitos.  

 

1º Passo: Ao abrir a imagem é necessário aumentar o contraste entre luzes e 

sombras. Existem diversas formas de fazer isto. Você pode ir em Levels & 

Cuvers ou Selective Color. 

Usaremos a segunda opção. Clique em Image>Adjustments>Selective Color.  

Em seguida clique na guia Colors e escolha a opção Blacks como mostrado na 

figura abaixo:  

 

 

 



 

2º Passo: Nessa janela coloque Black em +100% e mais uma vez vá na guia 

Colors novamente, mas desta vez selecione a opção Whites e altere o valor de 

Black para +60% 

 

3º Passo: Vá em Levels (ctrl+L) e coloque os valores 39 – 0,90 – 255, como 

indica a figura ao lado. 

 

Nessa ferramenta aumentamos o contraste da imagem, mas diferentemente da 

ferramenta anterior (Selective Color), onde você aumentou o contraste de duas 

cores específicas (Preto e Branco), dando maior definição de sombras e luzes.  

 

4º Passo: Vá em Select>Color Range para que apareça a janela da figura 

acima. 

 

Esta ferramenta merece um pouco de atenção, pois ela é fundamental neste 

trabalho e possui uma função muito interessante. Com ela é possível 

selecionar partes da imagem contém tonalidades de cores semelhantes. 

Para iniciar a seleção marque a opção Image e em seguida marque a caixa 

Invert para facilitar a visualização da seleção (a área escura da primeira 

imagem representa a parte a ser selecionada). 

 

Agora basta clicar na cor que deseja selecionar. Neste caso, eu cliquei na 

sombra do lado esquerdo do nariz do modelo para selecionar as sombras do 

rosto dele. Na barra Fuzziness coloque 130, esta barra representa a tolerância 

de seleção da cor escolhida, quanto maior a tolerância, maior será a área de 

seleção. 

Feito essas ações, clique em OK para obter uma seleção bem parecida com a 

segunda imagem. 

 

5º Passo: Agora é preciso preencher o espaço selecionado. 

Crie um novo layer indo em Layer>New> Layer (ctrl+shift+n) para colocar as 

sombras que marcam o rosto. 

 

Em seguida clique em Edit>Fill (shift+F5) para que apareça a primeira imagem. 

Na guia Contests, selecione a opção Color, preencha com a cor #190e03, 

clique OK. 

 

Em blending Mode coloque Darker e aperte em OK novamente. 



Preenchemos a seleção com um marrom escuro, valorizando ainda mais as 

sombras e linhas de expressão.  

 

 

 

6º Passo: Agora iremos dar uma tonalidade diferente à imagem. Vá em 

Image>Adjustments>Variations. 

Aparecerá uma tela com diversas de tonalidades para a fotografia, clique em 

More Yellow, em seguida em Darker e posteriormente clique em OK. 

O resultado será uma imagem com tom amarelo escuro. 

 

7º Passo: Selecione a ferramenta Burn Tool (O) e configure-a da seguinte 

forma: Range – Midtones, Exposure: 10%. Como a figura abaixo mostra. 

Com esta ferramenta iremos acenturar as sombras da fotografia. Após o uso 

satisfatório da Burn Tool selecione a Sharpen Tool (R)  e configure-a com o 

Strenght: 30%. Com esta é possível aumentar o contraste de partes específicas 

da imagem. Neste caso, a usaremos nas áreas com luminosidade, 

sobrancelhas e linhas de expressão. 

A figura dois mostra as áreas onde a Sharpen Tool deve ser aplicada. 

 

 



 

 

8º Passo: É preciso baixar o nível de saturação das cores, para isto vá em 

Image>Adjustments>Hue/Saturation, coloque a barra Saturation em -35% e 

clique em OK. 

 

O resultado será parecido com a imagem abaixo. 

 

9º Passo: Agora faltam apenas alguns retoques finais. Pegue a foto original, 

sobreponha à trabalhada. Coloque-a em 40% de Opacidade e Blending Mode:  

Overlay.  

Para dar maior expressividade à fotografia, você pode criar um novo Layer 

(Layer>New>Layer) e fazer algumas luzes nos olhos com o Brush Tool em 

60% opacidade. 

Algumas pessoas têm a curiosidade de sabercomo fica a palheta de Layers ao 

término do trabalho, a figura dois mostra a organização dos Layers no final do 

trabalho.  

 

Primeiro Abra uma fotografia qualquer que deseje aplicar os ajustes para fazer 

o melhoramento dela com o Photoshop. Se você já estiver com seu programa 

aberto pode ir na barra de menu do programa selecionar a opção arquivo > 

Abrir. 

Ajustes de Brilho e Contraste 

Este é um dos ajustes mais simples de se fazer no programa e se aplica em 

qualquer versão do editor. Com sua imagem aberta no editor vá em Imagem > 

ajuste > brilho e contraste. 

https://www.fotografia-dg.com/


E só ir deslizando os dois controles para esquerda ou para direita até chegar 

um efeito legal para sua foto. 

Ajustes de Níveis  

Os níveis são bastante utilizados no Photoshop para equilibrada os tons claros 

e escuros de uma fotografia. Para fazer esse ajuste é bem simples vá 

em Imagem > Ajustes > Níveis. 

 

Curvas  

Está opção é bem mais complexa do que as outras. Usuários profissionais 

optam por ela por fazer ajustes mais precisos e originais de iluminação. Ela 

possui uma linha, você precisa criar pontos sobre essa linha, que pode ser feito 

com cliques sobre ela, depois vá arrastando a linha para cima e para baixo. 

 

Existe diversas outras opções interessante de ajuste de cor e luz no editor que 

você podem conferir na mesma categoria das opções mostradas acima. 

  

Fotos tremidas e desfocadas 

Essa outra dica que vou mostrar aqui é um recurso exclusivo da nova versão 

do Photoshop. Trata-se de um filtro que faz o melhoramento de fotos que 

sairão tremidas e desfocadas. Para corrigir isso abra sua foto no Photoshop e 

vá em Filtro > Tornar Nítido > Redução de vibração. 

Ao fazer isso o editor já ira aplica o filtro, e mostras as configurações que você 

pode aumenta ou diminur para obter um resultado ainda melhor. 

Criando um efeito de dupla exposição no Photoshop 

Nós iremos chamar essas duas imagens de elemento frontal (o homem de 

negócios) e imagem de fundo (os prédios de Nova York). 

Primeiramente, abra o elemento frontal no Photoshop. A primeira coisa que 

faremos é retirar o fundo. Por isso é melhor escolher uma imagem com um 

fundo fácil de ser removido, como o nosso caso. 

Se necessário, você poderá utilizar a opção Refinar Aresta (atalho Alt + Ctrl + 

R) para um corte mais preciso. Depois de selecionado, basta excluir o fundo, 

como na imagem abaixo: 

Agora chegou a hora de inserir a imagem de fundo (no nosso caso, os prédios). 

Arraste a imagem para dentro do seu workspace no Photoshop. Ela abrirá em 



uma nova camada. Ajuste a opacidade dessa nova camada para 50% e 

posicione a imagem da forma que achar melhor. 

Depois disso, vamos criar uma máscara para essa nova camada que abriu. 

Preste atenção aos dois passos necessários para isso: 

Com o Ctrl pressionado, clique sobre a miniatura (seta nº1 na imagem abaixo) 

da camada do elemento frontal (no nosso caso, o homem de negócios). Isso 

criará uma seleção com a silhueta do homem. 

Com a seleção criada, selecione a camada da imagem de fundo (os prédios, no 

nosso caso) e depois clique em Adicionar Máscara de Vetor (seta nº2 na 

imagem abaixo). 

Agora você irá retornar a opacidade da primeira camada para 100% inverter a 

ordem das camadas. 

A imagem de fundo (os prédios) já está com a máscara atrás da imagem frontal 

(o homem de negócios). Agora iremos utilizar a borracha na imagem principal 

para que os prédios apareçam, 

Utilize a ferramenta borracha com diferentes níveis de opacidade. O segredo é 

ir apagando a imagem frontal aos poucos, experimentando a borracha em 

diferentes opacidades. 

Experimente deixar partes da roupa visíveis, para dar um efeito ainda mais 

interessante. No nosso caso, após aplicar a borracha sobre a primeira camada 

com opacidades variadas 

 

Como a imagem do prédio é em preto e branco, vamos deixar a imagem frontal 

em preto e branco também. Para isso, basta selecionar a primeira camada e 

clicar em Imagens >> Ajustes >> Preto-e-Branco. 

Nossa fotografia de dupla exposição já está ganhando forma, mas podemos ir 

além disso. Podemos alterar a máscara para criar um efeito interessante nas 

extremidades. 

Para isso, clique na camada do fundo e clique na miniatura da máscara. 

Lembre sempre do seguinte no que diz respeito à máscara: o que é branco 

aparece. O que é preto, esconde. 

Nós vamos recuperar uma pequena parte dos prédios na extremidade da foto. 

Para isso, selecione o pincel na cor branca e pinte um pouco acima da cabeça 

do homem. Não se esqueça de clicar na miniatura da máscara antes de fazer 

isso.  

Agora, vamos utilizar os próprios prédios para criar um recorte interessante. 



Depois de criar a seleção, basta mudar a cor do pincel para preto e pintar 

dentro da seleção. Dessa forma, esconderemos novamente parte do fundo, 

criando um efeito bem legal 

E para finalizar, basta repetir os passos da borracha e da máscara onde achar 

necessário. Depois, adicione um fundo com a cor que desejar, e faça pequenos 

ajustes de brilho, sombras e o que mais julgar interessante. 

É claro que existem várias outras maneiras de se chegar a um resultado 

semelhante. Mas essa é uma forma simples e rápida de criar um efeito de 

dupla exposição. 

Passo 1. Abra o Photoshop no computador, selecione “Arquivo” e depois 

“Abrir”. Encontre a foto que deseja e confirme em “Abrir”; 

Passo 2. Crie uma nova camada da imagem. Para isso, acesse a lateral na aba 

“Camadas”, clique com o botão direito no ícone da foto e selecione “Duplicar 

Camada”. Confirme a ação em “Ok”. Depois, desmarque o “Plano de Fundo” da 

visão, no ícone de “olho”, para ver as mudanças. Deixe a camada do topo 

selecionada. 

 

 

 

Passo 1. No lado esquerdo há uma barra de ferramentas do Photoshop. Veja 

três formas de recortar e remover o fundo da sua foto. A primeira é a “Varinha 

Mágica”. O recurso permite selecionar superfícies semelhantes de tom na foto. 

https://www.techtudo.com.br/tudo-sobre/adobe-photoshop.html


Clique no fundo e depois aperte o botão de “Shift” no teclado para clicar em 

áreas semelhante do fundo. 

Passo 2. Crie uma área do fundo totalmente selecionada e depois aperte o 

botão de “Delete” no teclado. Pronto. 

Recorte pela Seleção Rápida 

Passo 1. A ferramenta de “Seleção Rápida” também é prática para fotos com 

fundo de cores e características semelhantes. Basta clicar no fundo para criar a 

seleção completa 

 

Passo 2. Faça a marcação de todas as áreas do fundo e, se necessário, aperte 

o botão de “Shift” para somar áreas e “Alt” para reduzir áreas, caso tenha 

passado de algum limite que não queira cortar.  

Passo 3. Finalize com o botão de “Delete”. Note que cada área ficará em 

quadriculado, ou seja, sem fundo. 

Ferramenta de Caneta (Pen Tool) 

Passo 1. Por último, e mais preciso, está o recurso de Pen Tool. Com ela o 

usuário cria pontos de eixos para gerar a seleção. Em alguns casos é possível 

circular todo o objeto ou remover uma parte do fundo que não deseja; 

Passo 2. Faça a marcação de cada ponto, com cuidado, ao entorno da 

imagem. Para as curvas, mantenha o cursor pressionado e gire o eixo da 

marcação. Repita o processo até fechar a área completa, encontrando o 

primeiro ponto com o último; 

Passo 3. Clique com o botão direito na área selecionada e escolha “Criar 

Seleção”. Em seguida, com a área tracejada, apague o fundo no botão de 

“Delete” no teclado. Ele ficará quadriculado, como nos demais passos. 

Salvando as imagens 

Passo 1. Clique em “Arquivo” e depois em “Salvar como”. Caso queira salvar a 

foto sem o fundo, ou em transparente para edições futuras, é ideal usar o 

formato “PNG”. Caso prefira com o fundo branco escolha o formato “JPEG”. 

Confirme em “Salvar”. 

Melhorias na ferramenta Select & Mask (Ferramenta de Seleção e Máscaras) 

Todo o algoritmo da ferramenta de seleção e máscaras foi refeito, para 

trabalhar com seleções de imagens bem complexas. De acordo com a Adobe, 

a ideia é que a ferramenta seja capaz de entregar resultados mais realistas e 



precisos, principalmente em casos de recorte em que as cores do objeto e do 

fundo sejam muito parecidas. 

Para usufruir dessa funcionalidade melhorada, primeiro você utiliza a Quick 

Selection Tool e depois usa a Refine Edge Tool. Em poucos minutos testando 

essa nova funcionalidade eu percebi que sim, melhorou incrivelmente, 

principalmente no recorte de objetos complexos como árvores e cabelos. Com 

certeza vai melhorar em muito o trabalho de quem lida com edição de imagens. 

Suavização de traçados 

O Photoshop agora é capaz de criar uma suavização inteligente nos traçados 

de pincel (Brush Strokes). Para ver como essa nova funcionalidade atua, basta 

escolher um valor (0 a 100) na barra de opções para “Smoothing” (Suavização) 

em qualquer uma das ferramentas: Brush (Pincel), Pencil (Lápis), Mixer 

Brush (Pincel de Mistura) ou Eraser(Borracha). Se você colocar o valor 0, verá 

uma suavização igual a das versões antigas do Photoshop, e quanto maior o 

valor, mais suaves os traços. 

No modo Pulled String, você o cursor “puxando” o traço, como se houvesse 

uma corda. No modo Stroke Catch Up, o traço segue o cursor até você parar 

de traçar, e no modo Catch-Up On Stroke End, o traço se completa no ponto 

em que você soltou o mouse ou caneta. São modos bem interessantes de 

desenho, principalmente para artistas digitais e ilustradores que trabalham com 

tablets e mesas desenhadoras, pois cria traços muito naturais. 

Outra novidades dessas ferramentas é a possibilidade de simetria das pinturas, 

que pode ser ativada espelhando os desenhos para criar padrões e estampas 

complexos. Para ativar, vá em Preferências > Visualizações de tecnologia > 

Ativar simetria de pintura. 

3. Melhorias no Plugin Camera Raw 

O Camera Raw Editor é um plugin que permite importar e aprimorar imagens 

no formato raw, e só está disponível para usuários do Creative Cloud. A 

novidade é que você pode criar máscaras de seleção para ajustar os controles 

de Luminescência (Luminance) e Cor (Color). Isso permite modificar cores, 

tons e luzes de determinados elementos de uma imagem, uma funcionalidade 

muito interessante que permite um trabalho bem realista. 

4. Fontes Variáveis 

Essa nova funcionalidade é um negócio incrível que eu tenho certeza de que 

deixará muitos designers empolgados como eu fiquei. A Adobe não inventou as 

fontes variáveis, mas inserindo o suporte a esse formato de fontes OpenType, 

vai facilitar a vida de muita gente. A ideia é que você consiga alterar nas fontes 

suportadas (identificadas com um ícone com as letras VAR no painel) vários 



atributos como espessura, largura, inclinação, entre outros. Ou seja, você terá 

centenas de opções de fontes em uma só, usando controles deslizantes no 

painel de propriedades. 

5. Nova Caneta de Curvatura (Curvature Pen Tool) 

Essa nova ferramenta presente no grupo de ferramentas de curvatura deve 

ajudar a vida de muita gente que trabalha com formas e contornos. Você pode 

criar segmentos de curva com linhas retas e curvas suaves, com bastante 

facilidade. Além disso também é possível editar os pontos, remover e adicionar 

pontos de uma forma sem precisar trocar de ferramenta. 

Eu testei um pouco essa ferramenta e ela facilita bastante o traço e contorno 

de linhas, facilitando a criação de formas e linhas bem simétricas e suaves. 

O Photoshop CC 2018 veio cheio de novidades incríveis, eu listei apenas as 5 

que mais me agradaram pessoalmente. Entretanto, a lista de atualizações é 

grande e bem animadora. Agora, por exemplo, é possível copiar e colar layers 

usando o comando copiar e colar, importando todos os atributos do layer. Aliás, 

essa função ficou especialmente melhor quando se quer copiar de um 

documento para outro. Ao redimensionar imagens, os detalhes são 

preservados graças ao aumento assistido por um algoritmo de Inteligência 

Artificial. 

Outra coisa bacana implementada é a melhoria da biblioteca de pincéis. Agora, 

você pode trabalhar com presets de pincéis organizando-os em grupos, e se 

você importar presets de pincéis, eles entram na biblioteca como pincéis 

mesmo. Algo bem interessante principalmente para os mais novatos no 

software é o “Learn Panel”, em português, o painel Saiba Mais. Esse painel 

apresenta vários tutoriais sobre ferramentas e conceitos dentro do Photoshop, 

que são guias passo-a-passo bem explicativos. 

 

O Adobe Photoshop CS3 é um poderoso programa de edição de imagens que 

pode ser usado para criar ou preparar imagens para impressão e uso na 

internet, bem como para restaurar ou adicionar vida a imagens. Este programa 

é usado por profissionais e entusiastas e é compatível tanto para 

computadores com Windows, quanto Macs. 

Compre o Adobe Photoshop CS3. Este programa está disponível em CD, ou 

para download. 

 

Instale o Adobe Photoshop CS3. 



Passe algum tempo analisando os recursos disponíveis para os usuários do 

Adobe Photoshop CS3. Estes recursos incluem tutoriais, vídeos, fóruns e feeds 

RSS. 

Abra o Adobe Photoshop CS3. 

Comece a se familiarizar com a área de trabalho do Photoshop. 

A barra de menu está localizada no topo da área de trabalho e organiza os 

comandos por categoria. 

O painel de ferramentas (também chamado de paleta de ferramentas) está 

localizado do lado esquerdo do programa e contém ferramentas para adicionar 

texto e criar e editar artes, imagens e outros elementos gráficos. 

Muitas ferramentas têm diversas opções. O painel de controle (também 

chamado de barra de opções) exibe as opções (se disponíveis) da ferramenta 

com a qual você está trabalhando. 

A janela do documento é a parte principal da tela onde seu arquivo atual está 

sendo exibido. 

Os painéis (também chamados de paletas) são maneiras de monitorar as 

mudanças que você fez em seu trabalho e de fazer modificações. O painel de 

camadas (Layers) (também chamado de paleta de camadas, ou Layers Palette) 

é um painel usado com frequência. Você pode adicionar, ou remover painéis 

selecionando o painel que você quer adicionar a partir do menu Janela 

(Window), localizado na barra de menu. Você pode organizar ainda mais sua 

área de trabalho empilhando e fixando seus painéis. 

Abra a imagem que você deseja editar, ou crie uma nova imagem. 

Quando estiver criando uma nova imagem, especifique o tamanho, a resolução 

e o plano de fundo dela. 

Escolha "Tamanho da Imagem" ("Image Size") a partir do menu Imagem 

(Image) se você estiver trabalhando com uma imagem existente. O menu de 

imagem está localizado na barra de menu. 

Desmarque "Redefinir imagem" ("Resample Image"). Redefinir muda a 

quantidade de dados em uma imagem e pode afetar sua qualidade 

negativamente. 

Redimensione sua imagem ajustando a largura, ou altura em pixels, ou 

centímetros. Para ajustar o tamanho da imagem proporcionalmente, escolha 

"Manter proporção" ("Constrain Proportions"). 

Ajuste a resolução da imagem, se você achar necessário. 



Ajuste o modo de cor da sua imagem se necessário selecionando "Modo" 

("Mode") a partir do menu de imagem, na barra de menu. 

Modifique a cor dentro da sua imagem ajustando as camadas, curvas, matiz ou 

saturação, ou usando uma combinação dessas opções. Elas podem ser 

acessadas no submenu "Ajustes" ("Adjustments") do menu imagem. 

Retoque sua imagem conforme necessário selecionando a ferramenta 

adequada a partir do painel de ferramentas. 

Salve a imagem usando um novo nome de arquivo selecionando "Salvar como" 

("Save as") a partir do menu Arquivo (File). Evite modificar imagens originais. 

O Adobe Photoshop CS3 oferece várias opções de formato de arquivo. Para 

impressão, o formato .tif é o melhor, enquanto as imagens .jpg são as melhores 

para uso na web. 

O Adobe Photoshop CS3 contém diversas funcionalidades para retoque e 

transformação de imagens, incluindo ferramentas para adicionar, ou remover 

itens, focar, ou desfocar imagens, adicionar texto e corrigir falhas. 

Os modos de cores podem ser RGB (red, green, blue) ou CMYK (cyan, 

magenta, yellow, black). Eles determinam como as cores são exibidas em 

imagens impressas, ou eletrônicas. 

Resolução é o número de pixels por polegada em uma imagem. Quanto maior 

a resolução, maior a qualidade da imagem impressa. Se você estiver usando a 

imagem em um site, ou outro formato digital, uma resolução menor é aceitável. 

Uma resolução de 72 dpi geralmente é adequada para imagens da internet, 

enquanto 300 dpi é preferível para imagens impressas. 

 

Ferramentas 

Pincel – usando na maior parte do tempo para pintar, mesclar cores, etc. 

Você pode mudar os ajustes de acordo com suas necessidades (forma, 

opacidade, pressão, etc). 

Burn Tool (Ferramenta Superexposição) – será usada em três diferentes 

modos de mesclagem, para escurecer partes da pintura. 

Dodge Tool (Subexposição) – será usada em três diferentes mesclagens, 

para clarear partes da pintura. 

Eyedropper Tool (Ferramenta Conta-Gotas) – usada para pegar amostras 

de cor da pintura. 



Gradient Tool (Ferramenta Degradê) – usada para o início, onde será feita 

a colorização do fundo. 

 

Outras Ferramentas usadas com frequência: 

Liquify Tool – localizada no menu Filter > Liquify (Filtro > Dissolver) 

Ajustes de Levels, Curves, Hue ou Saturation (Níveis, Curvas, 

Matiz ou Saturação) – localizado no menu Image > Adjustments (Imagem > 

Ajustes) 

 

Mude o ajuste do pincel. Os ajustes mais usados estão marcados em 

vermelho. Isso vai permitir que você crie qualquer pincel de acordo com suas 

necessidades. Quando precisar de um pincel de ponta fina ou redonda mais 

dispersa, esses ajustes permitirão que você crie o pincel perfeito para sua 

necessidade. 

Você pode usar isso de referência para criar manualmente as cerdas de um 

pincel e criar texturas específicas, se quiser; o processo é basicamente o 

mesmo. Para salvar o pincel, clique no pequeno ícone próximo ao cesto no 

canto inferior direito no menu de formas (shapes). 

Se não tem uma mesa digitalizadora, pode usar o controle Fade 

control (controle de dispersão) em vez da Pen pressure (Pressão da caneta). 

Não esqueça de salvar sua imagem com frequência para evitar perda das 

configurações. 

 

Sombreamento 

 

Crie uma nova camada. Escolha uma cor clara (deve se encaixar a 

luminosidade da cena! Se quiser uma cena iluminada por luz fria, escolha um 

tom de azul claro, roxo ou verde, ou se quiser uma coloração quente, use cores 

como amarelo e laranja. A iluminação DEVE ser condizente!) e comece a 

adicionar luzes livremente (usei um pincel 

personalizado, Opacity Jitter ajustado para Pen Pressure, 0%). 

Você pode fazer o mesmo com as sombras quando achar que as luzes estão 

ok (as sombras devem ter cor oposta das luzes e também um tom mais escuro 

do que será a pele, normalmente isso funciona muito bem). 



A pele deve ter muitas cores. Não tenha medo de usar cores complementares 

que normalmente você não vê na pele de alguém, o resultado será muito mais 

natural depois que for suavizado. 

Usei áreas luminosas em azul claro, então as sombras devem ter laranja (na 

verdade, marrom-alaranjado, já que laranja seria muito claro aqui). Também 

adicionei algumas luzes amarelas nas áreas claras, para dar mais vida à pele e 

adicionar algum contraste. 

Escolha um pincel redondo, grande, borda dura (hard edge, rounded); pode 

variar entre 95 a 100% de dureza (hardness). Só tome cuidado para não usar 

pincéis aerógrafo, isso tornaria a pele um tanto artificial. Se preferir, use o 

mesmo pincel personalizado de antes, com Opacity Jitter ajustado para Pen 

pressure 0%. 

Comece a pintar adicionando cores e suavizando. Use a Eyedropper 

Tool (Conta-gotas) para escolher cores de sua paleta (se tiver uma) e 

também das suas pinceladas (segurando a tecla Alt enquanto usa o pincel, 

você usa temporariamente o Eyedropper). 

Dicas de suavização 

Adicione cores com seu pincel, então use o Eyedropper em cada pincelada, a 

cada duas ou três pinceladas, pintando de novo com opacidade mais 

baixa; pressione cada vez menos a caneta na tablet, até que fique uma 

mesclagem bem suave. 

 

Olhos 

Agora veremos como obter um efeito brilhante nos olhos e como adicionar 

profundidade e realismo a eles. 

Use a Dodge Tool (Ferramenta Subexposição, atalho: O), para adicionar 

luminosidade. Use a ferramenta com pincel redondo e suave, pequeno o 

suficientes para os pequenos detalhes. 

Escolhi o modo highlights, pois isto mantém a cor saturada o bastante, mas 

você pode tentar outros modos. Você pode também usar a Burn 

Tool (Ferramenta Superexposição) para escurecer regiões e criar efeito de 

profundidade. Não use o modo highlight, ou os olhos vão parecer sujos. Use o 

modo midtones ou shadow. 

Se não estiver satisfeito com o esquema de cores, você pode ir ao menu Image 

> Adjust > Levels (ou Curves, ou Hue/Saturation, etc), e fazer experiências com 

as configurações, até chegar ao que você espera. 



Para adicionar as pétalas caindo 

Crie uma nova camada, e selecione uma cor rosa clara (você pode usar um 

tom das sombras da pele, um pouco mais saturada). Use um pincel de borda 

suave, redondo (round, soft edge), ou o pincel personalizado usado antes, para 

pintá-las. 

Quando tiver adicionado pétalas o suficiente, você pode dar algum movimento 

a elas: vá ao menu Filter > Blur > Motion Blur (Filtro > Desfoque > Desfoque de 

movimento), e mudar os ajustes até ficar satisfeito. 

Esta técnica vai ajudar a adicionar pétalas pequenas no fundo. As pétalas da 

frente devem ser pintadas separadamente, não se esquecendo de fazer 

algumas mais nítidas, para obter efeito de profundidade e realismo (veja o 

exemplo da imagem anterior). Você pode detalhar um pouco as mais próximas, 

trabalhando em suas cores (pinte algum tipo de degradê nelas). 

Cabelos 

Cabelos são importantes por contribuir em muito na personalidade do 

personagem. 

Use o pincel grande redondo, borda dura (ou o mesmo pincel personalizado de 

antes), opacity jitter e size jitter em pen pressure, para desenhar as primeiras 

mechas de cabelo. Use uma cor escura; detalhes claros serão pintados sobre 

as mechas escuras, mas depois. Quando estiver satisfeito com a forma geral 

do cabelo, selecione um pincel pequeno, borda dura (opacity jitter e size 

jitter em pen pressure, 0%), e pinte cabelos individuais usando cores claras, 

especialmente nas partes que são afetadas por fontes de luz. Não se 

esqueça de adicionar cabelos que não fluem na mesma direção dos demais: 

pequenas imperfeições são importantes tanto nos cabelos quanto na pele. 

 

Pérolas 

Para pintar as pérolas, escolha um cinza claro não-neutro (levemente colorido). 

A cor não deve ser saturada, mas evite cinza neutro ou as pérolas parecerão 

apagadas. Nunca use cinza neutro nas suas pinturas, isso criaria uma “falha” 

na imagem. 

Use um pincel redondo, borda dura, para pintar a forma básica das pérolas. 

Escolha um cor mais escura e saturada e pinte uma sombra dentro da pérola, 

usando um pincel redondo, borda suave (soft edge, round). Agora você pode 

usar a Dodge tool (modo highlight) e adicionar a luminosidade final ao topo da 

pérola. Se quiser, claro, também pode usar uma cor saturada para a base. 


